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Introduction

Overview
ACS111 is a software program designed which is used for making pa-
rameter settings and for uploading datapoints from the OZW10 central
unit and from the devices connected to the OZW10.

The ACS111 is connected to the central unit via the RS-232 port, either
locally or via modem. The ACS111 can establish a connection to several
plants using various communication ports (COM ports), but not simulta-
neously.

The following applications are supported by the ACS111:

• Popcards
You can view and edit the datapoints of a device – similar to
using the Operating Instructions.

• Parameter Settings
You can handle the datapoints of a device defined in the de-
vice description as a standard parameter data record.

• Trend
You can cyclically prompt the datapoints of a device and
show them in a graphical window.

• Setup Protocol
You can prompt the setup datapoints of a device, enabling
you to generate a setup protocol.

• Memory Card
You can upload data from and download data to the memory
card and upload event data.

If this is the first time you work with the ACS111, we would advice you to
turn to section "The first steps".

System requirements
• Processor: 486 / 66 MHz for Windows 95 / 98

Pentium for Windows NT 4.0

• RAM: min. 24 MB for Windows 95 / 98
min. 32 MB for Windows NT 4.0

• Hard disk: min. 4 MB (the amount of free space required is
very much dependent on how many plants have been de-
fined and on the amount of data read from the plant)

• Screen: SVGA standard driver, 1024 x 768, 256 colours

• Port: serial COM1...COM4, up to 9'600 Baud for M-bus cen-
tral unit (direct or modem)
parallel port for security key

• Operating system: Windows 95, Windows 98 or Win-
dows NT 4.0
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• Diskette drive: 3.5 in, 1.4 Mbyte

• CD drive: 1 speed

Languages
You can select the language you require when starting up the ACS111.
Then, you can also decide whether or not the dialog for language selec-
tion shall be shown every time the ACS111 is started up.

It is not possible to change the language while the ACS111 is running.

Installation
The ACS111 is installed with the installation program.

Installing the software

For the steps to be followed, refer to the ACS111 Operating Manual.

Supplied files

The following files will be installed on the installation path of the ACS111
(....\ACS111\):

• ACS111.EXE: the current program

• ACS111xx.HLP: online help in different languages

• README.TXT: the latest information about the ACS111

• LPBTXTxx.VMC: text catalogs in different languages

• LPBUNT01.BUD: catalog of SI units

• Mxxxxxxx.APP: device description of a device

• Mxxxxxxx.MAR: additional file to the device description (op-
tional)

• Mxxxxxxx.MAW: additional file to the device description (op-
tional)

• Mxxxxxxx.PAR: parameter set of a device (optional)

The following files will be installed in the Windows system directory:

• FPGRID10.VBX: grid control for the ACS111

• GRAPH.VBX: grid control for the ACS111

• SFTTREE.DLL: tree control for the ACS111

• SFTTB.DLL: tab control for the ACS111

• GSW.EXE: program for the ACS111 trend graphs

• GSWDLL.DLL: part of GSW.EXE

The following files will be installed in the Windows directory:

• UNICOM.INI: INI file for UNICOM.EXE

• ACS111.INI: INI file for the ACS111
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These two files should not be edited manually. They are used to provide
settings and internal data that are plant-independent, which should be
stored permanently beyond the running time of the ACS111.

The following files will be installed in the Windows / Unicom directory:

• UNICOM.EXE: communication program

• *.mdm: various modem drivers

The installation program will not affect the AUTOEXEC.BAT and
CONFIG.SYS files.
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The Plant

Introduction
A plant consists of a OZW10 central unit and several devices that are
connected to the central unit.

Menus
The ACS111 supplies various menus which can change depending on
the menu you have selected.

Main menu

The ACS111 allows you to handle one plant at a time. After a new instal-
lation, no plants are in existence yet and, hence, not all menu items are
visible and accessible.
As soon as you have selected a new plant, the available menu items and
the tool bar will change.

The main menu offers you the following menu choices:

• Plant menu

• Application menu

• Edit menu

• View menu

• Extras menu

• Windows menu

• Help menu

Plant menu

The plant menu offers you the following menu choices:

Plant New tool

• New: the "Plant – Information" window appears. In this win-
dow, you can enter the settings for the new plant

Plant Open... tool

• Open...: the "Plant – Open" window appears. From this win-
dow, you can select one of the plants that already exist
(plant files)

• Close: the plant currently selected will be closed. If the se-
lected plant has been changed, you will always be asked if
you would like to save the changes

Plant Save tool

• Save: the plant currently selected will be saved in a plant
file. If you have not already saved the plant, the response
will be identical to menu item Plant – Save As...
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• Save as…: the "Save File As…" window appears. From this
window, you can choose where you want to have your plant
saved (plant file)

• Login...: the "Login" window appears. You will be prompted
to enter your name and your password

• Plant Information...: the "Plant – Information" window ap-
pears. In this window, you can change the settings of an ex-
isting plant

Plant Connect tool

• Connect: the connection to the plant is made. The window
"Opening the Connection – Information" appears. In this
window, you can watch how the connection is opened.
The command is made available only if a connection does
not yet exist

Plant Disconnect tool

• Disconnect: the connection to the plant will be cut. The
window "Closing the Connection – Information" appears. In
this window, you can watch how the connection is closed.
The command is made available only if a connection does
not exist

• Update Device List…: the list of users will be created. The
"Plant Directory – Information" window appears.
This window shows you how many devices in the plant have
already been detected. If a connection does not yet exist, it
will automatically be opened

• Group Device…: the window "Device Selection" appears. In
this window, you can group the existing devices according to
street and name. For more detailed information, refer to sec-
tion "Grouping devices"

• Print...: the content of the window currently active is printed
out. The standard "Print" window appears.
This command is a standard command in Windows applica-
tions, but is not yet implemented here

• Print Preview: a window appears, showing you how the
content of the window currently active would be printed out.
This command is a standard command in Windows applica-
tions, but is not yet implemented here

• Print Setup tool...: the standard "Print Setup" window ap-
pears. From this window, you can select a printer

• List of plants previously selected: from a list of a maxi-
mum of four previous plants, you can select one directly. If
the plant currently selected has been changed, you will al-
ways be asked if you would like to save the changes

• Exit: the ACS111 will be closed. If the plant currently se-
lected has been changed, you will always be asked if you
would like to save the changes. If a connection to the plant
still exists, it will automatically be cut

Application menu

The Application menu offers you the following menu choices:

• Popcards...: starts the "Popcards" application

• Parameter Settings...: starts the "Parameter Settings" appli-
cation
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• Trend...: starts the "Trend" application

• Memory Card: starts the "Memory Card" application

• Setup Protocol...: starts the "Setup Protocol" application

Edit menu

The Edit menu offers you the following menu choices:

• Undo: cancels the previous action

• Cut: places the selected objects on the clipboard

• Copy: copies the selected objects to the clipboard, which you
can then insert where required using the "Paste" command

• Paste: inserts the copied or cut objects at the selected loca-
tion

These menu choices are not yet offered by any of the applications, how-
ever.

View menu

The View menu offers you the following menu choices:

• Tool Bar: shows or hides the ACS111 tool bar

• Status Bar: shows or hides the ACS111 status bar

Extras menu

The Extras menu offers you the following menu choices:

• Language Selection: you can choose whether you want the
"Language" window displayed the next time the ACS111 is
started up

• Cover Picture: you can choose whether you want the cover
picture with the copyright information displayed the next time
the ACS111 is started up

• Connections...: a window appears, in which you can config-
ure new connections to plants (not yet implemented)

• Password...: the "Change Password" window appears. This
menu choice can be activated only if the current level "Ad-
ministrator"

Windows menu

The Windows menu offers you the following menu choices:

• New Window: the "Status" window of the current plant is
opened

• Cascade: arranges opened windows in a cascaded pattern
so that the top of each individual window is visible

• Tile: arranges opened windows side by side so that all win-
dows are visible

• Arrange Icons: arranges all icons (minimized windows) side
by side. The icons are arranged in rows
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• List of opened windows: activates an icon (minimized win-
dow)

Help menu

The Help menu offers you the following menu choices:

• Contents: shows the help choices available with the ACS111

• How to Use Help: shows the summary of topics for using
help. Selecting this command is the same as pressing the F1
key

Help Info… tool

• Info...: shows information about the program, gives the
ACS111 version number and copyright information

Process
When you work with the ACS111, certain processes must be observed.

First steps

Introduction
If this is the first time you work with the ACS111, this section introduces
you to the operation of the software program.

After starting up the ACS111, the cover picture appears, followed by a
window for selecting the required language. After selecting the language,
you will see the main window with the main menu.
For more information, refer to section "Starting up the ACS111".

Preparing a connection
To establish a connection to a plant, you need to connect the ACS111 to
an OZW10 central unit.
For more information about the preparation of a connection to a plant,
refer to section "Preparing a connection".

Selecting a plant

From the Plant menu, choose New. You can create a new plant in the
"Plant Information" window.
For more information about the creation of a new plant, refer to section
"Creating a new plant" or "Selecting a plant".

Making a connection

From the Plant menu, select Connect, thus establishing a connection to
the plant.
For more information about establishing a connection, refer to section
"Making a connection".
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Steps to be taken after the first time a connection is
opened
To make certain the devices present are indeed detected by the ACS111,
you should update the list of devices. This is the only way to show the
devices installed in the plant. From the Plant menu, select Update De-
vice List....
For more information about the detection of devices in a plant, refer to
section "Detecting devices".

Uploading data from devices and changing them
After having detected devices in a plant, you can upload data from them,
or change and record them. From the Application menu, select Pop-
cards... , Parameter Settings... , Trend..., Offline Trend or Setup Pro-
tocol....
For more information about the various applications, refer to section "Se-
lecting a plant".

Aborting a connection

To cut a connection to a plant, select Disconnect from the Plant menu.
For more information about cutting a connection to a plant, refer to sec-
tion "Aborting a connection".

Accessing data read
In some applications, plant data that have been uploaded can be ex-
ported as a file. Normally, these data are saved on the installation path of
the ACS111 (....\ACS111\<Application>\<File name>.<File type>. These
data can be accessed at any time using a standard spreadsheet program
or editor.

Starting up the ACS111

The ACS111 is a Windows 3.1 application which can also be run on Win-
dows 95/98 and Windows NT.

Starting up on Windows 3.1 /3.11:

1. To start the ACS111, double-click on the ACS111 icon in
Program Manager.

2. The ACS111 can also be started directly from the File Man-
ager.

Starting up on Windows 95/98 and Windows NT:

1. Choose the Start button and point at Programs.

2. Point at the ACS111 folder which contains the program and
choose the ACS111 program.

3. The ACS111 can also be started directly from Explorer.

After starting up the ACS111, the "Language" window appears. From this
window, select the required language and choose the "Continue" button.
If you do not want this window to appear the next time you start up the
ACS111, choose "Do not show this dialog anymore".

After selecting the language, the title picure with information about the
software appears.
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If this is the first time you start the software program, the "Edit pass-
words" window appears. This window prompts you to define a password
for the different access levels of the ACS111. For more detailed informa-
tion, refer to section "Editing passwords".

If this is not the first time you start the software program and you have
assigned the passwords to end-users and service staff, the "Login" win-
dow appears. Enter your personal password and choose the "OK" button.
For more detailed information, refer to section "Logging in at the
ACS111".

After successfully logging in, the main window appears and, at bottom
left, the plant's "Status" icon.

Handling a plant

To be able to establish a connection with a plant, you need to define the
connection in the ACS111 first.

Creating a new plant

Introduction

Each plant to which you want to establish a connection must first be cre-
ated by you (COM port, etc.).

Procedure

Plant New tool

To create a plant, select New from the Plant menu. The "Plant – Infor-
mation" window appears. In this window, you can create a new plant or
change the settings of an existing plant.

If, later on, you want to change the settings made for the new plant, sec-
tion "Changing a plant" will offer you help.

After having created a plant and after having prepared the connection to
it (refer to section "Preparing a connection"), you can open the connec-
tion (refer to section "Making a connection").

Changing a plant

Introduction

Each plant that you have created and to which you would like to establish
a connection can also be changed by you.

Procedure

To change an existing plant, select Plant Information… from the Plant
menu.
The "Plant – Information" window appears. In this window, you can
change the settings of an existing plant.

Selecting a plant

Introduction

Each plant that you have created can be selected by you.



16/72

Siemens Building Technologies Operating Instructions ACS111 CE1B5386en
Landis & Staefa Division The Plant 23.10.2000

Procedure

Plant Open… tool

To open a plant, select Open… from the Plant menu. The "Plant –
Open" window appears. From this window, you can select one of the
plants that already exist.
If you select a plant from the list, information relating to that plant will be
displayed, e.g. description of the plant and of the COM port that is used
for communicating with the plant.

If, later on, you want to change the settings made for the plant, section
"Changing a plant" will offer you help.

After having selected a plant and after having prepared the connection to
it (refer to section "Preparing a connection"), you can open the connec-
tion (refer to section "Making a connection").

Grouping devices

Introduction

When the ACS111 detects a device, it cannot decide on its own to which
user the device belongs. If you wish to assign the individual devices of
your consumers, you have to do it manually.

Procedure

Make certain that none of the applications is open. If one or several of the
applications are open, close them before you proceed.

Select Grouping Devices... from the Plant menu to open the "Device
Selection" window. Now, select the device(s) that you want to combine in
one group and then choose the "Group Devices…" button. The "Change
Device Address" window will appear.
Now, if you wish, you can enter the street and the name of the consumer
to whom the device(s) belong(s). Choose the "OK" button to make the
grouping.

Repeat the procedure until all devices are grouped.

If you do not find some of the devices in the "Device List:", you have to
update the list. In that case, choose the "Update Device List" button and
the ACS111 will automatically establish a connection to the plant to re-
read the current plant. If the required devices are still not available, the
OZW10 central unit is either incorrectly configured or has not yet acqui-
red all devices.

Connections within a plant

This section provides information about how to prepare, open and abort a
connection.

Preparing a connection

Introduction

To be able to establish a connection to a plant, it must be set up first.

Procedure

In the case of a direct connection, connect your PC via a free COM port
together with a NULL modem to the OZW10 central unit.

In the case of a connection via the telephone line, you need to connect
one modem to a free COM port of your PC and a second one to the
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OZW10 central unit. Then, you have to configure the serial port of your
PC. For details, refer to section "Configuring a connection".

For more information, refer to the ACS111 Operating Manual.

Configuring a connection

Introduction

Before you can establish a connection via the telephone line, you have to
configure it first.

Procedure

Select Connections... from the Extras menu. The "Connections" window
appears. It is subdivided into two parts. In the upper half, the type of con-
nection for each serial port of your PC can be defined. In the lower half,
the connection selected above can be configured.

Setting the type of connection

From the "Ports" list, choose the button of the setting (down arrow) that
you would like to change. A list of different drivers that you can select ap-
pears. A differentiation must be made between Modem (driver for con-
nections via modem) and Direct (driver for a direct connection). The re-
quired driver is selected by clicking on it.

If you do not find the driver you need, you must load it from a selection of
drivers provided with the ACS111 or create it as new.

Loading the driver

When choosing the "Load" button, the "Load driver" window appears. In
the lower half of the window, you can search for the driver file you requi-
re. After clicking on the required driver file, the "Driver:" list appears (one
or serval drivers).
Now, select the required driver and then choose the "Load" button. The
message "The driver(s) has (have) been successfully loaded" will appear.
If you need additional drivers, repeat the above procedure until you have
loaded all the drivers required. The "Load driver" window will be closed
by choosing the "OK" button.

In the "Connections" window, you can now assign one of the loaded
drivers to the required serial port.

Creating a new driver

If the type of driver required for your modem is not included in the scope
of delivery of the ACS111, you can create it yourself.

For that purpose, choose the "New" button and the "New Modem Driver"
window appears. In that window, you can configure the serial port under
"Connection" and make the necessary modem settings under "Standard"
and "Extended".

Connection

To make changes to the serial port, choose the button of the required
setting (down arrow). A list with a choice of setting values appears from
which you can select one.

Standard and Extended

To make changes to the modem setting, double-click on the required set-
ting. The pointer appears in the entry field and you can change the exi-
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sting setting.
We draw your attention to the fact that wong settings may lead to pro-
blems when opening a connection. Also refer to the manual provided by
the supplier of your modem.

In the entry field "Driver Names:", you can assign your modem’s model
no. to the settings made, if you wish.

By choosing the "Save" button, the settings made will be stored and the
"New Modem Driver" window closed.

The created driver can now be selected under the name entered.

Editing drivers

Drivers that already exist can be edited. For that purpose, select the re-
quired driver from the "Ports:" list and choose the "Edit" button. The "Edit
driver" window appears. The procedure is the same as that described
above in section "Creating a new driver".

Cancelling a driver

Loaded or newly created drivers can be removed from the list of selec-
table drivers. For that purpose, choose the "Cancel" button and the "Can-
cel Driver" window appears. Select the driver(s) you want to cancel and
choose the "Cancel" button. The selected drivers will then be removed
from the list. You can close the "Cancel Driver" window by choosing the
"OK" button.

Making a connection

Introduction

After having prepared a connection (refer to section "Preparing a connec-
tion") and after having created a new plant (refer to section "Creating a
new plant"), or opened a plant (refer to section "Selecting a plant"), you
can establish a connection to the plant.

The command is available only when no connection exists.

Procedure

Plant Connect tool

Select Connect from the Plant menu to connect a plant. The "Opening
the Connection – Information" window appears, where you can watch
how the connection is opened. After the connection has been estab-
lished, the window disappears. If an error occurred while the connection
was opened, an error message with the possible causes and actions will
be displayed.

After having established a connection to a plant, you can read data from
the devices, or change and record them (refer to sections "Popcards",
"Parameter Settings", "Trend", "Memory Card" and "Setup Protocol").

Aborting a connection

Introduction

Naturally, any connection that you have established (refer to section
"Making a connection") can also be cut by you.

The command is available only when no connection exists.
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Procedure

Plant Disconnect tool

To cut a connection to the plant, select Disconnect from the Plant
menu. The "Closing the Connection – Information" window appears,
where you can watch how the connection is closed.

Plant access rights

The ACS111 uses different access rights that can be protected with
passwords. These access rights or passwords are the same for all plants
that you are going to define or that you have already defined.

To learn more about access rights and passwords, refer to sections "Ed-
iting passwords" and "Logging in with the ACS111"

Plant applications

As soon as a plant in the ACS111 is opened, the latter makes available a
number of applications in menu item "Application".

Selecting an application
The ACS111 offers you the following applications:

• Popcards

• Parameter Settings

• Trend

• Memory Card

• Setup Protocol

Procedure

From the Application menu, select Popcards..., Parameter Settings...,
Trend... or Setup Protocol....The "Popcards", "Parameter Settings",
"Trend", "Memory Card" or "Setup Protocol" window appears.

You can start several applications at the same time.

Plant devices

To be able to read or write data off devices with the ACS111, the devices
must be detected first.

Detecting devices

Introduction

In the case of a new plant or when making changes to a plant, the de-
vices contained in the plant are not yet known. This means that you have
no devices to choose from, or the available devices are not the right
ones.

Procedure

To include all devices of the plant in the list, select Update Device List…
from the Plant menu. The "Plant Directory – Information" window ap-
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pears, showing you the devices in the plant that have already been de-
tected.
If not yet made, a connection will automatically be opened. If that is the
case, the "Opening a Connection – Information" window will appear first,
followed by the "Plant Directory – Information" window.

Selecting a device

Introduction

If you want to upload data from or download data to the device in an ap-
plication (e.g. "Popcards" or "Parameter Settings"), you need to select
such a device first.

Procedure

To select a device for handling, choose Device... from the menu of these
applications. The "Device Selection" window appears. This window
shows you all devices detected in the plant.

Datapoints of a plant

Datapoints are the communication objects of a plant.

Selecting datapoints

Introduction

In some applications (such as "Trend"), you need to select one or several
datapoints.

Procedure

To select one or several datapoints, select Datapoints... from the menu
of this application. The "Datapoint Selection" window appears. This win-
dow shows you all devices detected in the plant and all selectable data-
points of a device.

Commands and changes of a datapoint

Introduction

In some applications (such as "Popcards" or "Parameter Settings"), you
can change the value of a datapoint. Please note that it is not possible to
change all datapoints.

To change a datapoint, you require the necessary write access which is
dependent on the user level.

Procedure

In one of these applications, a button connected to the handling of a da-
tapoint is shown on the line of a datapoint. If you choose that button, the
"Datapoint – Commands" window appears.
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Windows

Plant devices

Eine Anlage besteht aus mindestens einer OZW10 M-Bus Zentrale und
mehreren M-Bus Geräten.

Device Selection

Introduction

In some applications (such as "Popcards" or "Trend"), you need to select
a device first, from which you would like to read data, for instance.

This window shows all devices detected in the plant. If you select a de-
vice from the list, the lower part of the window will display additional in-
formation about the device. Also, in column "Device Information", you can
enter additional information about the device families, segments and de-
vices.

In terms of operation, "Device Selection" is similar to Windows' File Man-
ager or Windows' Explorer.

Depending on the location from which you have made the device selec-
tion, you can select only one device or several devices.

Buttons

• OK: the device(s) selected from the list is used

• Cancel: no device will be selected

• Update Device List: the list of devices will be built up. The
"Plant Directory – Information" window appears, showing the
number of plant devices that have already been detected.
If not yet made, a connection will automatically be opened
(same as menu item Plant – Update Device List...)

• Select All: selects all devices. Depending the application,
this button becomes available

Changing the device address
When making changes to the internal address list of the OZW10, the de-
vice address of a device may change. Such a change is detected when
updating the device list and the device will be regrouped.

Also, it is possible that – by accident – the same addresses have been
assigned to the devices and, in addition, the serial numbers of the devi-
ces are identical also. This kind of situation must never occur, since the
serial number and the ID clearly identify a device! Naturally, the "Device
Selection" window will show such devices as being identical and, therefo-
re, as one single device!

Devices that are no longer present
It may happen that a device previously detected in a plant is no longer
identifiable because it is no longer present or faulty. Such a device would
be displayed in red italics. When you click on this red device, another
button will appear:
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Button

• Remove Device: the device detected on the list will be re-
moved

If the device was not deleted and it suddenly reappeared (e.g. after a
power failure), it would become black again (Windows standard setting).

Plant Directory – Information

Introduction

This window shows you the running process of plant directory reading. As
soon as a device is included in the plant directory, the counter with the
number of detected devices advances.

Datapoints of a plant

Datapoints are the communication objects of a plant. To perform certain
functions, they can be selected or changed.

Datapoint Selection

Introduction

In certain applications, such as "Trend", you need to select one or several
datapoints to start trending, for example.

Depending on the location from which you have selected the datapoints,
you are given the choice of selecting datapoints of different devices si-
multaneously or you can select only the datapoints of the device prede-
fined by the application.

Selecting the device

From the "Device List", select the device whose datapoints you would like
to select.

CAUTION: make certain the required device is highlighted in blue. Only
then can the datapoints be selected.

Selecting a datapoint

From the "Datapoints" list, select the datapoint(s) you are interested in.
By choosing "Add>>", you can add the selected datapoint(s) to the table
on the right.

CAUTION: make certain the required datapoint is highlighted in blue.

The table on the right shows the datapoints that have already been se-
lected.

Buttons

• Update Device List: the plant directory will be built up. The
"Plant Directory – Information" window appears, showing the
number of plant devices that have already been detected.
If not yet made, a connection will automatically be opened
(same as menu item Plant – Update Device List...)

• Add >>: the selected datapoints are added to the right side
of the table. The table contains all the datapoints selected
thus far. The Add >> button can be clicked repeatedly. The
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selected datapoints will be added to the table if not yet pres-
ent

• Delete: a datapoint selected from the table will be deleted

• ↑↑↑↑: the datapoint selected from the table will be moved up-
ward by one line

• ↓↓↓↓:the datapoint selected from the table will be moved down-
ward by one line

• OK: the datapoints contained in the table will be accepted

• Cancel: the previous selection will not be changed

List

• Mask: the datapoints given on the list are only those that use
the masks selected by you

Datapoint – Commands

Introduction

In some applications (such as "Popcards" or "Parameter Settings"), you
can change the value of a datapoint.

The appearance of this window depends on the type of datapoint. The
following buttons are used, depending on the datapoint:

Buttons

• Download: normal write access.
A datapoint never supports both access rights simultane-
ously: downloading and overwriting

• Set Default: the datapoint is set to the default value

• Set Unit: setting the counter unit

General information about a plant

The ACS111 can administer several plants, but it can open only one plant
at a time and establish a connection.

Plant – Open

Introduction

In this window, you can open a plant. The window is comparable to the
usual "Open" window of a Windows program. As soon as a valid plant is
selected, additional information about the file and the plant will be dis-
played.

Text boxes (relating to file and plant information)

• Plant Name: specific name of the plant.

• Description and notes that you have given about a plant (e.g.
location of plant). Refer to the "Plant – Information" window

• Server Type: with the ACS111, the OZW10 is always the
server to the plant
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• COM port that you have selected for the communication be-
tween your PC and the OZW10. Refer to the "Plant – Infor-
mation" window

Plant – Information

Introduction

This window displays specific information about the plant.

Entry box

• Plant Name: here, you can give the plant a specific name

Text boxes

• Name of creator of plant and date of creation

• Name of user who has made changes to the plant and date
of change

Entry box

• Description: here, you can give a description of the plant
and make notes (e.g. location of plant)

List

• Server Type: with ACS111 the OZW10 is always the server
to the plant

• COM port: select your PC's COM port for communicating
with the OZW10

Entry box

• Plant phone no.: phone number that is dialled via the tele-
phone line during the time the connection is opened, to es-
tablish the connection to the central unit OZW10.

• Callback: if you want the OZW10 to call you back, you can
indicate the phone number of the telephone line here to
which your modem is connected

• Code no.: An OZW10 central unit always has a code. To
establish a connection to the OZW10, the code has to be
entered.

Buttons

• OK: the changes made will be accepted

• Cancel: the changes made will not be accepted

Status

Introduction
This window supplies you with information about the plant, communica-
tion, and the current user.
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Plant section

Text boxes

• Name of plant

• Description of plant (also refer to the "Plant – Information"
window)

• Name of creator of plant and date of creation

• Name of modifier of plant and date of modification

Communication section

Text boxes

• Plant of COM port plant (also refer to the "Plant – Informa-
tion" window)

• Status of communication (disconnected, connected, etc.)

• Number of devices detected in the plant

Actual User level section

Text boxes

• User's user level

Opening / Closing the Connection – Information

Introduction

This window supplies you with information about the running process of
opening or closing a connection.

Opening the connection

1. The ACS111 opens a connection to the OZW10 central unit.

Closing the connection

1. The ACS111 closes a connection to the OZW10 central unit.

Generated files
The ACS111 generates a variety of files in order to store its data.

Plant file

Introduction
The information about the individual plants is saved in a plant file, which
contains:

• Information about the user (name and user level)

• Information about the plant (creation, date of creation, de-
scription, etc.)
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• The device list with your information about the devices

• Version of plant

The following file name and file name extension are proposed:

• File name: selectable

• Extension: plt (for "plant")

Format
The file cannot be read as clear text since the data are saved in binary
format.
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Popcards

Introduction
In the "Popcards" application, you can view and edit datapoints of a de-
vice – similar to the Operating Instructions. The datapoints are assigned
to a number of pages. The same datapoints may be found on various
pages. The standard Popcards will be created based on the formation of
groups in the device description.

You are also given the choice of creating your own user-defined Pop-
cards, but only one set of user-defined Popcards per device description
is allowed.

Depending on the selected view, not all datapoints will be shown to you.

Menus
After having selected Popcards from the Application menu, the Pop-
cards menu appears. Also, the menu items on the View menu have
changed.

The following menus and menu items have not been changed by your
choice: Plant, Application, Edit, Extras, Windows and Help.

Popcards menu

The Popcards menu offers you the following menu choices:

• Select Device...: the "Device Selection" window appears.
From this window, you can select a device whose data you
would like to have displayed

• Book:

• Standard: checks whether the user-defined book has
been changed. In the affirmative case, you can save the
book or cancel the command. Then, the standard book
from the device description is loaded

• User-defined: opens the user-defined book. If there is
no book, a new book with an empty page will be created.
Save: saves the user-defined book in a user Popcard file

• Page:

• New...: adds a new page to the book. You are prompted
to give the name of the page

• Delete: deletes the current page, but before really delet-
ing, your confirmation is required.
Note: the book must always contain at least one page.
For this reason, you cannot delete the last page

• Rename..: you can rename the current page
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• Change Order…: the "Change Order" window appears.
In this window, you can move the current page to some
other location (order)

• Datapoints...: the "Datapoint Selection" window ap-
pears. In this window, you can handle the datapoints of
the current page

View menu

In the "Popcards" application, the View menu offers you the following
choices. Depending on the activation of the various masks, the following
datapoints will be displayed:

• All Data: shows all datapoints

• No Data: shows no datapoints

• Overview: refer to the masks

• Configuration: refer to the masks

• Setpoints: refer to the masks

• Control Parameters: refer to the masks

• Diagnostics: refer to the masks

• I/Os: refer to the masks

• Normal User: refer to the masks

• Commissioning Report: refer to the masks

• Tool Bar: the tool bar is shown or hidden

• Status Bar: the status bar is shown or hidden

Processes
The datapoints of a device are assigned to a number Popcard pages.

Selecting a device

Introduction
If you would like to upload or download the data of a device for remote
operation, you need to select such a device first.
If you have already used such a device in another application, it will be
selected automatically. If the application is the first to be started in the
plant, the device last handled in the plant will be selected.

Procedure

To select a device for handling, choose Select Device… from the Pop-
cards menu. The "Device Selection" window appears. The selection can
also be made by choosing the Device... button from the "Popcards" win-
dow.
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Displaying datapoints on a Popcard page

Introduction
After opening a Popcard page, the datapoint values will be shown in red.
As soon as datapoints have been uploaded, they appear in black.

Procedure
The individual pages can be viewed by choosing "Enduser", "Switching
program Mo-Fr", "Switching program Sa-Su", etc.

Commands and changes of a datapoint

Introduction
You can change the value of a datapoint. Please note that not all data-
points can be changed.
To change a datapoint, you need to have the respective write access
which depends on your user level.

Procedure

Choose the button in the E column and the "Datapoint – Commands"
window will appear.

Creating user-defined Popcards

Introduction
If you wish, you can create your own Popcards for each device descrip-
tion.

Procedure

1. Choose Select Device… from the Popcards menu.

2. Choose Book – User-defined from the Popcards menu, or
directly the check box User-defined.

3. To create a new page, select Page – New from the Pop-
cards menu.

4. To insert datapoints into this page, select Page – Data-
points… from the Popcards menu. The "Datapoint Selec-
tion" window appears.

5. If required, repeat the procedure starting with item 3.

6. To save your own Popcards in a user Popcard file, select
Book – Save from the Popcards menu.

Windows
The datapoints of a device are assigned to a number of Popcard pages.
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Popcards

Introduction
This is the main window in the "Popcards" application.

The book
The book is comprised of several pages whereby each page contains a
certain number of datapoints. The subdivision of pages and the assign-
ment of datapoints to the various pages are defined by the respective de-
vice description. The same datapoint may exist on several pages.
A datapoint is displayed in several columns. The columns have the fol-
lowing meaning:

Column Description

No. Consecutive numbering of datapoints on a page

Datapoints Name of the datapoint

Value Value of the datapoint

Unit Unit of the datapoint

S The S-columns contain a button. When choosing this button,
the "Datapoint – Status" window with the respective status of
the datapoint is displayed

E The E-columns contain a button. When choosing this button,
the "Datapoint – Commands" window for handling the respec-
tive datapoint is displayed

Buttons

• Device...: the "Device Selection" window appears. In this
window, you can select a device whose data you would like
to have displayed

Check boxes

• Standard: you can load the standard book from the device
description. Prior to that, it is checked whether you have
changed the user-defined book. In the affirmative case, you
can store the book or cancel the command

• User-defined: you can load the user-defined book. If no
book is present, a new one with an empty page will be cre-
ated. The book is saved in a user Popcard file

User-defined Popcards

Once user-specific Popcards have been produced, they can be matched
to your needs at any time.

Change Order

Introduction

Select Page | Change Order... from the Popcards menu. The "Change
Order" window appears. In this window, you can move the current page
to some other location (order).
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Buttons

• ↑↑↑↑: the page selected from the table will be moved upward by
one line

• ↓↓↓↓: the page selected from the table will be moved downward
by one line

• OK: the order will be accepted

• Cancel: the current order will not be changed

Renaming a Page

Introduction

Select Page | Rename... from the Popcards menu. The "Rename" win-
dow appears. In this window, you can change the name of the current
page.

Entry box

• New Name: new page name

Buttons

• OK: the new name will be accepted

• Cancel: the name will not be changed

Generated files
The ACS111 generates a number of files in order to store its data.

User Popcard file

Introduction
The information about your own Popcards will be saved in a user Pop-
card file. Both the file name and file name extension are automatically
determined as follows:

• File name: name of the device description (maximum eight
characters)

• Extension: .apc or .opc (if the selected device has an OEM
device description loaded)

Format
The file cannot be read as clear text since the data are saved in binary
format.
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Parameter Settings

Introduction
In the "Parameter Settings" application, you can handle all datapoints of a
device that, in the device description, are defined as a standard parame-
ter data record. For all devices of the same parameter description, the
standard parameter data record is identical.

You also have the choice of editing and saving the parameter sets with-
out requiring a physical connection to a device.

You can save all parameter sets in one file. For further handling, e.g. with
a spreadsheet program, you can also export the parameter sets.

Depending on the selected view, not all datapoints are shown to the user.

Menus
After having selected Parameter Settings from the Application menu,
the Parameter Settings menu appears. Also, the menu items on the
View menu have changed.

The following menus and menu items have not been changed by your
choice: Plant, Application, Edit, Extras, Windows and Help.

Parameter Settings menu

The Parameter Settings menu offers you the following menu choices:

• Select Device...: the "Device Selection" window appears.
From this window, you can select a device whose data you
would like to have displayed

• Select Device Type...: the "Select Device Type" window ap-
pears. By selecting a type of device, you do not select a
physical device but only the type. The device type is unambi-
guously assigned to a device description

• Select All: selects all datapoints

• Deselect All: deselects all datapoints

• Download Default...: sets value and status of the selected
datapoints of the current device to its default values

• Set 1 and Set 2:

• New: checks whether the current data record has been
changed. In the affirmative case, you can save the data
record or cancel the action. New initializes the data rec-
ord with the default values from the device description

• Open...: the "Open Parameter Set" window appears.
From this window, you can choose a data record that you
would like to open
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• Open any parameter set...: a window appears for
opening a parameter setting file. After having selected a
file, you can open a parameter set

• Save: saves the data record.
If you have not yet saved the data record, the response
is the same as with menu choice Save As...

• Save As...: the "Save Parameter Set" window appears.
In this window, you can save the data set under a name
in a preselected parameter setting file

• Upload...: uploads the value and the status of the se-
lected data record datapoints from the current device.
This menu item is activated only if a connection to the
plant exists

• Download...: downloads the value / status of the se-
lected data record datapoints to the current device. This
menu item is activated only if a connection to the plant
exists

• Delete Set...: the "Delete Parameter Set" window appears. In
this window, you can delete saved data records

• Export table…: you can save the data records (standard, set
1 and set 2) in a parameter setting text file, whereby the indi-
vidual columns are separated by tabs. For this purpose, the
"Save Data As…." window appears. From this window, you
can choose where and under what name you would like to
save the table

View menu

In the "Parameter Settings" application, the View menu offers you the
following menu choices. Depending on the activation of the various
masks, the following datapoints will be displayed:

• All Data: shows all datapoints

• No Data: does not show any datapoints

• Overview: refer to the masks

• Configuration: refer to the masks

• Setpoints: refer to the masks

• Control Parameters: refer to the masks

• Diagnostics: refer to the masks

• I/Os: refer to the masks

• Normal User: refer to the masks

• Setup Protocol: refer to the masks

• Tool Bar: the tool bar is shown or hidden

• Status Bar: the status bar is shown or hidden
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Processes
To be able to make parameter settings, you need to select the device
whose datapoint you would like to edit.

Selecting a device

Introduction
If you want to download or upload the data of a device for making pa-
rameter settings, you need to select the device first.
If you have already used such a device in some other application, it will
be selected automatically. If the application is the first to be started in the
plant, the device last handled in the plant will be selected.

Procedure

To select a device for handling, choose Select Device… from the Pa-
rameter Settings menu. The "Device Selection" window appears. The
selection can also be made by choosing the Device... button from the
"Parameter Settings" window.

If this is the first time the application is selected, the window "Parameter
Settings – Information" appears. The window also appears if, during the
parameter setting process, you choose some other type of device.

Creating a new parameter set

Introduction
After having selected a device, the parameter table will be created. Set 1
and set 2 contain the default values. In this case, it is not necessary to
establish a connection to the device! The procedure for set 1 and set 2 is
identical.

Procedure
1. In set 1, you would like to assign a datapoint some other

value.

2. Choose button E on the respective datapoint line. The win-
dow "Data Points – Commands" appears.

3. In the window "Data Points – Commands", assign the data-
point a new value and exit the window by using the "Down-
load" command. In the "Parameter Settings" window, you see
that the value of the datapoint in set 1 has changed. The new
value is not equal (!) (column D) to the default value.

4. If required, repeat steps 1-3.

5. To save set 1, choose menu item Set 1 – Save from the Pa-
rameter Settings menu. The "Save Parameter Set" window
appears.

6. Enter a device description and the name of the parameter
set. All parameter sets of a device type are saved in one file.
You need not enter the name of the parameter setting file.
This file name will be determined automatically based on the
selected device and thus its device description.
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Please note that at this point no values in the device have been changed
yet.

Downloading a parameter set to a device

Introduction
After having selected a device, the parameter table will be created. Set 1
and set 2 contain the default values. In this case, a connection to the de-
vice must exist! The procedure for set 1 and set 2 is identical.

Procedure

1. To load set 1 with a parameter set, choose menu item Set 1
– Open… from the Parameter Settings menu. The
"Open Parameter Set" window appears. Choose a parameter
set from that window.

2. After opening the parameter set, select the datapoints (col-
umn Se) whose values you would like to download to the de-
vice.

3. You can now transfer the values of the selected datapoints to
the selected device by choosing Download Set 1... , or via
the menu Parameter Settings – Download Set 1.

OK in the column "Result of transmission" indicates that the transmis-
sion to the device has been successful.

Please note that, during the downloading process, it is not only the value
but also the datapoint status that is set. Value and status are handled in
the "Data Points – Commands" window.

Working with parameter sets

Introduction
You need not enter the name of a parameter setting file. The file name
will be defined automatically, based on the selected device and thus its
device description.
Due to the further development of a device, it is now possible that the de-
vice description must be modified also. As a result, the names of the pa-
rameter setting files are not fully identical, the difference being the last
character of the parameter setting file. To avoid extra work (setting the
parameter sets for the "new" device), you can load the parameter sets of
the "old" device.

Procedure
1. Select the "new" device.

2. From the menu Parameter Settings Set 1 or Set 2 select
the menu item Open any parameter set....

3. Select the parameter setting file of an "old" device from which
you would like to open a parameter set.

4. Select a parameter set from the "Open Parameter Set" win-
dow.

5. A check is made to see whether the parameters of the se-
lected parameter set are compatible with those of the "new"
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device.
The "Information" window displays the following information:
Number of parameters not loaded:
These parameters no longer exist in the device description of
the "new" device, which means they could not be loaded.
Parameters with data type change:
In the device description of the "new" device, these parame-
ters use another data type, which means they could not be
loaded.
By choosing OK, the parameter table with all "compatible"
parameters will be generated.

Please consider that the parameter set just loaded will not automatically
be saved in the parameter setting file of the "new" device. If you want to
save it, proceed with section "Creating a new parameter set".

Working with the device type

Introduction
A device parameter set can also be handled without having knowledge of
the device's address and without ever having used this device in a plant.
This means that no connection to the device is required.

Procedure

1. Create a new plant (Plant – New menu).

2. Choose menu item Parameter Settings from the Applica-
tion menu.

3. Choose menu item Select Device Type… from the Parame-
ter Settings menu. This can also be accomplished by
choosing the Type... button from the "Parameter Settings"
window. The "Select Device Type" window appears.

4. Select a device type from the "Select Device Type" window.
This device type is now used for the parameter settings.
However, downloading and uploading the parameter sets
make no longer sense and, for this reason, the respective
buttons are deactivated.

The further steps are described in sections "Creating a new parameter
set" and "Downloading a parameter set to a device".

Working with set 1 and set 2

Introduction
The parameter settings contain two data records (set 1 and set 2). These
can be uploaded and changed completely autonomously. It should be
considered, however, that both data records always refer only to the se-
lected device or the selected device type.
Thanks to the two data records, it is possible to compare them in a
straightforward manner (columns D and S1).

Procedure
Also refer to section "Creating a new parameter set".
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Windows
With the parameter settings, the datapoints of a device are shown in a
main window.

Parameter Settings

Introduction
This is the main window of the "Parameter Settings" application.

The parameter table
The parameter table uses one line for each datapoint.

The default values of the datapoints, as well as parameter set 1 and pa-
rameter set 2 can be viewed in various columns. The values of the col-
umns "Default", "Parameter set 1" and "Parameter set 2" are automati-
cally compared with one another and the various comparisons shown in
additional columns.

A datapoint is displayed in several columns, which have the following
meaning:

Column Description

Select Indicates whether the datapoint has been selected

Name and unit Description of datapoint

Default Default value from the device description

Set 1 + 2 User-defined data records

S The S-columns contain a button.
When choosing it, the "Datapoint – Status" window with
the respective datapoint status appears

E The E-columns contain a button.
When choosing it, the "Datapoint – Commands" window
for handling the respective datapoint appears

-D, -S1 Columns "-D" and "-S1" indicate whether the value in the
set is equal to "=" or not equal to "!" the compared set
(default "-D" or set 1 "-S1")

Result of transmis-
sion

The transmission result indicates whether, during the
datapoint uploading or downloading process, the data-
point has indeed been handled

Buttons

• Device...: the "Device Selection" window appears. From this
window, you can select a device whose data you would like
to have displayed

• Type...: the "Select Device Type" window appears. By se-
lecting a device type, it is not a physical device that is se-
lected but only its type. The device type is unambiguously
assigned to a device description

• Upload Set 1...: uploads the value and status of the selected
datapoints of data record 1 from the current device

• Download Set 1...: downloads the value / status of the se-
lected datapoints of data record 1 to the current device
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• Upload Set 2...: uploads the value and status of the selected
datapoints of data record 2 from the current device

• Download Set 2...: downloads the value / status of the se-
lected datapoints of data record 2 to the current device

Open Parameter Set / Save Parameter Set

Open Parameter Set
In this window, you can open the parameter sets created by you for han-
dling.

Text box

• Device Type Description: type of selected device

Entry field

• Parameter Set: name of parameter set you would like to
open

List of parameter sets

• By clicking on a parameter set contained in this list, the set is
copied to the entry box

Check box

• Read Selection: when this check box is activated, the selec-
tions made in the parameter set will be read

Buttons

• OK: the selected parameter set will be opened

• Cancel: any selection made will be disregarded

Save Parameter Set
The parameter sets created by you can be saved in this window.

Entry fields

• Device Type Description: the selected device type can be
described in more detail (e.g. RVL470, from version 1.4)

• Parameter Set: name under which the parameter set shall
be saved (e.g. plant configuration set 1)

Check box

• Write Selection: when this check box is activated, the selec-
tions made in the parameter table will be saved in the pa-
rameter set

Buttons

• OK: the parameter set is selected

• Cancel: any change made by you will be disregarded
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Delete Parameter Sets

Introduction
In this window, you can delete the parameter sets created by you.

Text box

• Device Type Description: type of selected device

List of parameter sets

• By clicking on a parameter set contained in this list, the set is
selected

Buttons

• Delete: the selected parameter set will be deleted

• OK: the selected parameter set will be opened

• Cancel: any selection made by you will be disregarded

Select Device Type

Introduction
In this window, you do not select a physical device but its type. The de-
vice type is unambiguously assigned to a device description.
This device type is now used for the parameter settings. However, up-
loading and downloading the parameter sets no longer make sense and
are therefore deactivated, but you can still handle the parameter sets.

Table

Column Description

File name Name of file that contains the device's description

Description A more detailed description of the file. This description is
identical to the entry box "Device Type Description" in
the "Open Parameter Set" window

Buttons

• OK: the selected parameter set will be saved or opened

• Cancel: any selection or change made by you will be disre-
garded

Generated files
The ACS111 generates a number of files in order to store its data.
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Parameter setting file

Introduction
All parameter sets of a device are saved in a parameter setting file.
File name and file name extension are automatically determined as fol-
lows:

• File name: name of device description (eight characters)

• Extension: par (for parameter setting)

Format
The file cannot be read as clear text since the data are saved in binary
format.

Parameter setting text file

Introduction
The data records (standard, set 1 and set 2) can be exported to a pa-
rameter setting text file, enabling the data to be further handled in a
spreadsheet program. For this purpose, select menu item Export Ta-
ble… from the Parameter Settings menu.
The following file name and file name extension are proposed:

• File name: selectable

• Extension: pat (for parameter setting text file)

Format
The file can be read as clear text and the individual columns are sepa-
rated by tabs.
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Trend

Introduction
In the "Trend" application, the datapoints of any devices can be selected
and cyclically prompted. The data received are saved and recorded in the
graphical window.

Data that have been received and saved can always be uploaded again
and viewed at a later time.

It is also possible to generate a setup protocol at the start of trending and
after trending is terminated. The setup protocols that can be generated in
this application can be opened for viewing in the "Setup Protocol" appli-
cation.

The sample files can also be exported to a spreadsheet program for fur-
ther handling.

Menus
After having selected Trend from the Application menu, the Trend
menu appears. Also, the menu items on the View menu have changed.

The following menus and menu items have not been changed by your
choice: Plant, Application, Edit, Extras, Windows and Help.

Trend menu

The Trend menu offers you the following menu choices:

• Select Datapoints...: the "Data Point Selection" window ap-
pears. From this window, you can select datapoints that shall
be recorded

• New Trend File: the "Open" window appears. Before that, a
check is made to find out whether the current trend file has
been changed. In the affirmative case, you can save the
trend file or cancel the action. New Trend File removes all
datapoints from the trend table as well as all data that have
already been uploaded

• Open Trend File...: the "Open" window appears. Before that,
a check is made to find out whether the current trend file has
been changed. In the affirmative case, you can save the
trend file or cancel the action.
Open a Trend File... opens a trend file that has previously
been saved. In that case, a check is made to see if the data-
points in the trend file that you would like to open are avail-
able on the current plant. If one or several datapoints are no
longer available, the file will not be loaded and the error mes-
sage will be displayed

• Save Trend File: saves the datapoints of the trend table in a
file. If you have not yet saved the file, the response is identi-
cal to menu item Save Trend File As...
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• Save Trend File As...: the "Save As…" window appears.
You can save the selected datapoints in a new trend file

• Open Sample File...: the "Open" window appears. You can
use this window to open a sample file that has previously
been created. These files contain all information about the
datapoints on the lists as well as all data that have been re-
corded.
The file is also uploaded if one or several datapoints on the
current plant are no longer available. In that case, an error
message would be displayed only if you attempted to start
the trend process

• Save Sample File As...: the "Save As…" window appears.
You can save the current recording in a new sample file

• Export Sample File...: the "Save As…" window appears.
You can save the current recording in a sample text file

View menu

In the "Trend" application, the View menu offers you the following menu
choices. Depending on the activation of the various masks, the following
datapoints will be displayed:

• All Data: shows all datapoints

• No Data: does not show any datapoints

• Overview: refer to the masks

• Configuration: refer to the masks

• Setpoints: refer to the masks

• Control Parameters: refer to the masks

• Diagnostics: refer to the masks

• I/Os: refer to the masks

• Normal User: refer to the masks

• Setup Protokol: refer to the masks

• Tool Bar: the tool bar is shown or hidden

• Status Bar: the status bar is shown or hidden

Processes
To be able to work with Trend, you first need to select the datapoints
which you would like to log.

Selecting datapoints

Introduction
If you want to upload datapoints of a device for recording purposes, you
need to select the device and the datapoints first. The selected data-
points will then be listed in the trend table, whereby the information about
each datapoint and the properties appears in various columns.
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Procedure

To select a device and datapoints for handling, choose Select Data
Points…. from the Trend menu. The "Datapoint Selection" window ap-
pears.
This can also be accomplished by choosing the Datapoints... button from
the "Trend" window.

Recording datapoints

Introduction
This application is used to record datapoints.

Procedure
1. Select the datapoints that you would like to have recorded

(refer to section "Selecting datapoints").

2. Set the sample interval and make certain your recording will
not be stopped prematurely due to storage space problems.
For this purpose, choose the File button. The "Sample File –
Information" window appears.

3. Decide whether you would like to obtain a setup protocol at
the start and / or at the end of the recording process.

4. Choose the Start button to start recording. The "Trend – In-
formation" window appears.

During the recording process, you can remove the datapoints from or add
them to the graphical window by choosing the button in column O of the
trend table, but it is always all data that are acquired, independent of
whether or not the datapoint is displayed in the graphical window.

The captured data are cyclically saved in a sample file.

You can terminate the recording by choosing the Stop button.

Scaling the graphics

Introduction
The scaling of the graphic can be done by the ACS111 or you can do it
yourself.

Procedure

1. Select the graphics' Time Axis. Please note that this variable
is dependent upon the sample rate.

2. Select automatic or manual scaling.

3. With manual scaling, select the scale of the axis (Y-min and
Y-max). To include these scales in the graphic, choose the
Accept button.

Please note that, during the recording process, you can only view the last
time window of the recorded data.

If you stop recording, you can move the time window in any manner de-
sired by using the scrollbar. By clicking the left or the right arrow of the
scrollbar, the graphic is moved by one sample rate.
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Windows
The datapoints to be logged and the graph itself are shown in the main
window of the application.

Trend

Introduction
This is the main window of the "Trend" application.

Datapoint Selection section

Buttons

• Datapoints: the "Datapoint Selection" window appears. From
this window, you can select datapoints that shall be recorded

• Remove: a datapoint selected from the trend table will be
removed

• Remove All: all datapoints contained in the trend table will
be removed

Trend table

The selected datapoints will be listed as shown below. The information
about each datapoint and the properties are displayed in various col-
umns:

Column Description

O (online) Datapoint is shown in the graphical window. This setting is pos-
sible only if the datapoint allows setting V (value) to be made

V (value) The data of the datapoint are available as values

T (text) The data of the datapoint are available as text. When double-
clicking on the text box, the "Trend Datapoint – Information"
window appears

C (channel) The individual graphics are referenced based on this number

D (device
family)

Family the device belongs to (controller, central unit, etc.)

S (segment) Segment of device of the datapoint

D (device) Device number of device of the datapoint

Datapoint Name of the datapoint

Off (offset) Adjustable offset. This offset is used for moving the datapoint
on the Y-axis in the graphical window. When double-clicking on
the offset box, the "Trend Datapoint – Information" window ap-
pears, where you can adjust the offset

Recording section

Entry fields

• Sample Rate [s]: sample interval of datapoints. The rate
cannot be changed during the recording process.
If a sample rate of 1 or 2 s is selected, the data will be saved
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in a new sample file as early as 8 or 12 hours later. The
numbering of the file will automatically be adjusted

Buttons

• File: the "Sample File – Information" window appears, which
delivers information about the current recording

• Start: the "Trend – Information" window appears where in-
formation about the current reading can be entered. Then the
recording will be started

• Stop: the recording will be stopped

Check boxes

• Setup Protocol on Start: a setup protocol file can be gener-
ated at the start of the recording

• Setup Protocol on Stop: a setup protocol file can be gener-
ated at the end of the recording

Scaling section

Entry fields

• Time Axis [min]: you can set the maximum visible range of
the graphical window. The size is dependent on the sample
rate. For instance, with a sample rate of 15 seconds, the
maximum time axis that can be set is 100 minutes

• Y-Min: manual scaling of y-axis. Check box Automatic may
not be set

• Y-Max: manual scaling of x-axis. Check box Automatic may
not be set

Buttons

• Large Graph: you can change from the small graph to the
large graph

• Accept: you can accept the changes made to the scaling.
These can be viewed directly in the graph

Check box

• Automatic: the ACS111 determines the most suitable scal-
ing. This will be set such that all data in the graphical window
are visible. If the scaling shall be set manually, however, this
check box max not be set

Small Graph section
The right side of the window shows the small graph.

Trend Datapoint – Information

Introduction
In this window, you can handle the properties of the selected datapoints
in the trend table.
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Text box
Name of datapoint selected by you.

Check boxes

• Record Datapoint Online: on or off

• Save Value of Datapoint as a Number: on or off

• Save Value of Datapoint as Text: on or off

Entry field

• Offset in Online: adjustable offset. This offset is used for
moving the datapoint on the Y-axis in the graphical window

Trend – Information

Introduction
In this window, you can add special information to each recording.

Entry boxes

• Plant Name: this name may or may not be the same as the
description given in the Description box in the "Plant – In-
formation" window (menu Plant – Plant Information...)

• Location: location of plant

• Installer: this name may or may not be the same as the
name of the current user

• Remarks:

Sample File – Information

Introduction
This window supplies you with information about the current recording.

Text fields

• Sample Time [s]: sample time set

• Max. File Size after 24 h [Byte]: the maximum size of the
recording file (smp file) after a recording time of 24 hours is
calculated

• Max. Recording Time [h]: based on the free storage space,
the maximum active recording time is calculated

• Available Storage Space [KB]: amount of storage space
currently available

Generated files
The ACS111 generates a number of files in order to store its data.
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Trend file

Introduction
This file contains a list of datapoints that have been compiled for record-
ing. There are no recorded values in this file.
The following file name and file name extension are proposed:

• File name: selectable

• Extension: trn. (for trend)

Format
The file cannot be read as clear text since the data are saved in binary
format.

Sample file

Introduction
In this file, the recorded values are stored. The data captured during
trend recording are cyclically saved in one of the sample files.
File name and file name extension are automatically determined as fol-
lows:

• File name: <year><month><day><00..99>

• Extension: .smp(for sample)

The numbers 00…99 are used for sequential numbering of the smp files.
The number is increased by 1 each time recording is restarted.
If recording runs for several days, the data after midnight will be saved in
a new file whose file name corresponds to the current date, and the num-
bering of the smp files will be reset to 00.

Format
The file cannot be read as clear text since the data are saved in binary
format.

Sample text file

Introduction
The current recorded values can be exported to a sample text file, ena-
bling the data to be further handled in a spreadsheet program. To do this,
choose menu item Export Sample File… from the Trend menu.
The following file name and file name extension are proposed:

• File name: selectable

• Extension: grf (for german Grafik)

Format
The file can be read as clear text and the individual columns are sepa-
rated by tabs.
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Setup protocol file

Introduction
A setup protocol file can be generated at the beginning and at the end of
each trend recording. In that case, the setup data saved in this file are the
data of the devices whose datapoints are prompted by trend recording.
The following file name and file name extension are proposed:

• File name at the start: <year><month><day><S><0..9>

• File name at the end: <year><month><day><E><0..9>

• Extension: spr (for Setup Protocol)

Format
The file cannot be read as clear text since the data are saved in binary
format.
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Memory Card

Introduction
The "Memory Card" application is subdivided into two parts:

1) Left section: from a memory card, files can be:

• uploaded

• or cleared

A memory card can also be formatted.

2) Right section: in the ACS111, this list box only shows the entry
MBUS.BIL. This file can only be read. It provides a choice of information
about the connected devices.

Menus
After having selected menu item Memory Card from the Application
menu, the Memory Card menu appears. Also, the menu items on the
View menu have changed.

The following menus and menu items have not been affected by your
selection: Plant, Application, Edit, Extras, Window and Help.

Memory Card menu

The Memory Card menu offers you the following menu choices:

• Read Directory: the contents of the memory card in the
OZW10 central unit will be uploaded and displayed

• Format: the memory card used will be formatted

• Upload File: the "Save As..." window appears where you can
save the selected file in any directory. If, at the same time, an
editor is defined, it will be started and the selected file will be
shown

• Delete File: this menu item is not available for the ACS111

• Copy File: this menu item is not available for the ACS111

• Down File: this menu item is not available for the ACS111

View menu

In the "Memory Card" application, the View menu offers you the following
menu choices. Depending on the activation of the various masks, the
following datapoints will be displayed:

• All Data: shows all datapoints

• No Data: does not show any datapoints

• Overview: refer to the masks
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• Configuration: refer to the masks

• Setpoints: refer to the masks

• Control Parameters: refer to the masks

• Diagnostics: refer to the masks

• I/Os: refer to the masks

• Normal User: refer to the masks

• Setup Protocol: refer to the masks

• Tool Bar: the tool bar is shown or hidden

• Status Bar: the status bar is shown or hidden

Processes
Using the "Memory Card" application, you can read files off the plug-in
memory card of the OZW10 or the billing file.

Reading a file off the memory card

Introduction
If you want to read a file off the memory card of the OZW10, proceed as
follows:

Procedure
Select the required file from the list box "File on memory card:". Choose
the "Read File" button, whereupon the "Save as…" dialog appears. Here,
you can indicate where you would like to have the file saved. After having
selected the path and the file name, choose the "OK" button to start the
reading process. The "Read Data" dialog now appears. Here, you can
watch the reading process.

If you have defined an editor in the "Editor" entry field, the question "Do
you want to start the configured editor?" appears after the reading proc-
ess. In the affirmative case, choose the "Yes" button.

Reading the billing file off the OZW10 central
unit

Introduction
The OZW10 central unit delivers a billing file which you can read with the
help of the ACS111.

Procedure
Reading the billing file is identical to reading a file off the memory card.
Select OZW_SS1.BIL from the list box "Data from central unit:". Then, the
procedure is the same as described in "Reading a file off the memory
card".
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Windows
The available files of the OZW10 central unit will be shown in the main
window.

Memory Card

Introduction
This is the main window of the "Memory card" application.

Buttons

• Read Directory: refer to "Memory Card" menu

• Formatting: refer to "Memory Card" menu

• Upload File: refer to "Memory Card" menu

• Delete File: refer to "Memory Card" menu

• Copy File(s): refer to "Memory Card" menu

• Down File: refer to "Memory Card" menu

Text field

• Editor: if a file is read from the memory card via "Read File",
it will be shown with the editor parameterized here

Lists

• File on memory card: here, all files contained on the mem-
ory card will be shown

• File from central unit: here, the history directory will be
shown

• File Format: filter for the relevant list

Select path

Buttons

• Copy Files: copies the selected files to the selected folder

• Cancel: cancels the entire action

• Create Directory: creates a directory

• Network: connects a network drive
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Setup Protocol

Introduction
The "Setup Protocol" application can be used to generate a setup proto-
col of all devices contained in the current plant. The service data of each
device can be viewed.

The uploaded setup data can be saved in a file. These can be read in
again. Even the setup data generated by device data in the "Trend" ap-
plication can be read in again here.

For further handling, e.g. in a spreadsheet program, the data can also be
exported.

Menus
After having selected menu item Setup Protocol from the Application
menu, the Setup Protocol menu appears. Also, the menu items on the
View menu have changed.

The following menus and menu items have not been affected by your
selection: Plant, Application, Edit, Extras, Window and Help.

Setup Protocol menu

The Setup Protocol menu offers you the following menu choices:

• Device...: the "Device Selection" window appears. From this
window, you can select devices whose data you would like to
have displayed. The Device List will be filled up with these
selected devices

• Open...: the "Open" window appears. You can use it to open
a setup protocol file that has already been generated. This
setup protocol file may also have been generated by the
"Trend" application

• Save As...: the "Save As…" window appears. You can save
the currently uploaded setup protocol in a new setup protocol
file

• Export...: the "Save As…" window appears. You can save
the current service data in a setup protocol text file

View menu

In the "Setup Protocol" application, the View menu offers you the follow-
ing menu choices. Depending on the activation of the various masks, the
following datapoints will be displayed:

• All Data: shows all datapoints

• No Data: does not show any datapoints

• Overview: refer to the masks
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• Configuration: refer to the masks

• Setpoints: refer to the masks

• Control Parameters: refer to the masks

• Diagnostics: refer to the masks

• I/Os: refer to the masks

• Normal User: refer to the masks

• Setup Protokol: refer to the masks

• Tool Bar: the tool bar is shown or hidden

• Status Bar: the status bar is shown or hidden

Processes
Before a setup protocol can be produced, you need to select the required
devices.

Generating a Setup Protocol

Introduction
This application is used to generate a setup protocol of one or several
devices.

Procedure

1. To select one or more devices, choose the Device... button
from the "Setup Protocol" window. The "Device Selection"
window appears.

2. If a connection does not yet exist, open one.

3. Choose the Start button to start generating the setup proto-
col. A window appears, showing you the actual generation of
the protocol. In this window, you can stop the action prema-
turely (Cancel button).

4. Save the data uploaded.

When generation of the protocol is terminated, the setup data uploaded
become visible in the Setup Protocol Table. By making use of the De-
vice List, the data of the devices can be viewed, one device after the
other.

Windows
The result of a setup protocol is shown in the main window of the "Setup
Protocol" application.
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Setup Protocol

Introduction
This is the main window of the "Setup Protocol" application. The setup
data are listed in a table.

Buttons

• Device...: the "Device Selection" window appears. From this
window, you can select devices whose data you would like to
have displayed. The Device List will be filled up with the se-
lected devices

• Start: generation of the setup protocol is started. A window
appears, showing you the actual generation of the protocol.
This button becomes available only when a connection to a
plant actually exists and the Device List is not empty

List

• Device List: the setup data of each device can be viewed

Setup protocol table

Column Description

Datapoints Name of the datapoint

Value Value of the datapoint

Unit Unit of the datapoint

Status Status of the datapoint

Generated files
The ACS111 generates a number of files in order to store its data.

Setup protocol file

Introduction
This file contains the setup data of devices.
The following file name and file name extension are proposed:

• File name: file name of plant

• Extension: spr (for Setup Protocol)

Format
The file cannot be read as clear text since the data are saved in binary
format.



55/72

Siemens Building Technologies Operating Instructions ACS111 CE1B5386en
Landis & Staefa Division Setup Protocol 23.10.2000

Setup protocol text file

Introduction
The current setup data can be exported to a setup protocol text file, ena-
bling the data to be further handled in a spreadsheet program.
To do this, select menu item Export… from the Setup Protocol menu.
The following file name and file name extension are proposed:

• File name: file name of plant

• Extension: spt (for Setup Protocol Text)

Format
The file can be read as clear text and the individual columns are sepa-
rated by tabs.
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Plant Diagram

Introduction
The "Plant Diagram" application enables you to present the key data of a
controller, meter, or of groups of controllers or meters.

This application produces a standard plant diagram for every type of
meter and for all plant types of every type of controller. You are also
given the choice of generating a user-defined plant diagram in which you
can enter the values wherever you like.

Before the "Plant Diagram" application can be used, a configuration file
must be created. It is recommended to use the same filename as that of
the plant, but you can also choose some other name if you wish.

Menus
After having selected menu item Plant Diagram... from the Application
menu, Plant Diagram menu also appears. In addition, the menu items on
the View menu change.

Your choice does not change the following menus and menu items:
Plant, Application, Edit, Extras, Windows and Help.

Plant Diagram menu

The Plant Diagram menu provides the following menu choices:

• Select device...: the "Device selection" window appears.
From that windows, you can select the device whose plant
diagram you would like to have displayed

• Plant Diagram:

• Standard: enables you to change from "Standard" to
"User-defined"

• User-defined: enables you to change from "User-
defined" to "Standard"

• Standard description:
Accessible only with special version.

• Edit: creating or modifying a standard description

• Save: stores the standard description

• Close: closes the standard description

• User-defined description:

• New: creation of a user-defined description

• Save: stores the current user-defined description

• Undo: cancels the current user-defined description

• Configuration
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• New: generates a new configuration

• Open: opens an existing configuration

• Close: closes the current configuration

View menu

The View menu provides the following menu items in the "Plant Diagram"
application. Depending on the activation of the different masks, the fol-
lowing menu items will appear:

• All Data: shows all datapoints

• No Data: does not show any datapoints

• Overview Data: see masks

• Configuration Data: see masks

• Setpoints: see masks

• Control Parameters: see masks

• Diagnostic Data: see masks

• I/O Data: see masks

• End-user Data: see masks

• Setup Protocol: see masks

• Tool Bar: the tool bar is shown or hidden

• Status Bar: the status bar is shown or hidden

Processes
Before a plant diagram can be shown, a configuration must be generated.
This procedure must be followed for every plant.

Creating a new configuration file

Introduction

To be able to work with the "Plant Diagram" application, a configuration
file must be generated for every plant.

Procedure

1. Select Configuration new from the Plant Diagram menu.

2. Enter the name of the configuration in the "Filename" win-
dow.
It is recommended to use the same name as that of plant,
because this will facilitate the continuation of your work.

3. Choose the "OK" button to complete the procedure.
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Opening an existing configuration file

Introduction
To work with the configuration of some other plant, you can open it.

Procedure
1. Open an existing plant or create a new one.

2. Select Open configuration from the Plant Diagram menu.

3. Select a configuration and then choose the "OK" button.

Working with the standard description

Introduction
The ACS111 in supplied complete with the standard descriptions. As
soon as you select a controller or meter, the associated standard de-
scription will be loaded and the plant diagram displayed.

Procedure
1. Open an existing plant or create a new one.

2. Select the required device. By clicking on the "Devices..."
button, the list with all available devices appears. Also refer
to section "Device selection".

Editing the standard description

Introduction
The standard description can only be edited with the special version of
the ACS111. It is possible however to create a user-defined description.

Procedure
1. Open an existing plant or create a new one if not yet done

so.

2. From the Plant Diagram menu, select "Standard description
– Edit...".

3. A dialog appears. The list box shows all the pictures con-
tained in the standard directory. Select the picture you re-
quire.

4. If the selected picture has no datapoint file yet, the following
dialog allows you to select if you wish to use an existing file
or if you want to create a new one. Thi first 5 characters of
the datapoint file and the picture must agree.

5. Then, selected an adequate device description for the pic-
ture. The most practical device description is the one at the
bottom of the list box.

6. Choose the "OK" button to get to the editor.
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Working with the user-defined description

Introduction
If the standard description supplied with the ACS111 does not display the
required data, you can create your own description.

Once you have created a user-defined description, it will always be dis-
played whenever you select the relevant device. But you can also switch
back to the standard description at any time.

Procedure
1. Open an existing plant or create a new one.

2. Select check box "User-defined" from the "Diagram" window.

3. If you have created a user-defined description before, it will
be displayed.
If you have not yet created a user-defined description, the
"New description" window will appear.

Editing the user-defined description

The user-defined description can be edited at any time. The only precon-
dition is that the ACS111 must be connected to the respective plant.

Procedure
1. Open an existing plant or create a new one.

2. Select the required device.

3. Use the right mouse button to click anywhere in the "Plant
Diagram" window. Select "Edit mode" from the pop-up menu,
thus activating the edit mode.

4. You can now select an existing datapoint in order to edit it.

Use the left mouse button to click on the required datapoint.
A frame around the datapoint indicates that it is selected.

Press the right mouse button to let a pop-up menu appear.
Select "Copy" if you want to copy and paste the datapoint.
Select "Undo" if you want to delete the respective datapoint.
Select "Properties" if you want to edit the datapoint. The
"Properties" window will appear.

Windows
The main window of the "Plant Diagram" application shows the plant dia-
gram of the selected controller or meter.

Plant Diagram

Introduction
This is the main window of the "Plant Diagram" application. It shows the
plant diagram of the selected controller or meter.
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Procedure

Buttons

• Device...: the "Device selection" window appears. From this
window, you can select a device whose plant diagram you
would like to view.
The "Device selection" window appears only if a connection
to a plant exists.

Check boxes

• Standard: the standard plant diagram of the selected device
appears.

• User-defined: the user-defined plant diagram appears. If a
user-defined plant diagram does not yet exist, the "New de-
scription" window appears.
Once a user-defined plant diagram is created, it will always
be the default diagram.

New description

Introduction
From this window, you can select how the new description shall be cre-
ated. You can adopt either the picture of the standard description or a
new one which you have created yourself, for example.

Procedure

Check boxes

• Copy standard description to user-defined: select this
check box to adopt the user-defined plant diagram

• Copy library picture to user-defined: select this check box
to adopt a picture from the library as the user-defined plant
diagram. But that diagram contains no datapoints yet

• New: select any picture, which will then be displayed as the
user-defined plant diagram. But that diagram contains no
datapoints yet

List box

• Preview: this list box shows the pictures contained in the li-
brary list

Buttons

• OK: the required picture is adopted and displayed as the
user-defined plant diagram

• Cancel: no user-defined plant diagram will be created
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Editing the standard description

Introduction
From this window, you can select the required standard description that
you would like to edit. You need to select the device description whose
standard description you would like to change. You also have to select
the plant diagram. For all meters and the OZW10 central unit, plant dia-
gram 0 always applies.

Procedure

List boxes

• Device description: select the device description whose
standard description you would like to change. The device
descriptions identified by an asterisk (*) already have a stan-
dard description

• Plant diagrams for: after having selected the required de-
vice description, the plant diagrams already available for the
description will be displayed

Buttons

• Add plant diagram: after having chosen the required picture
and plant diagram, you can adopt the settings by clicking on
"Add" and then edit them in the "Plant Diagram" window

• Delete plant diagram: the selected plant diagram will be
deleted

• OK: when you have selected an existing standard descrip-
tion, you can adopt it by choosing the "OK" button and then
edit it in the "Plant Diagram" window

• Cancel: editing of the standard description will be cancelled

Properties

Introduction
In this window, you can select the properties of a datapoint.

Procedure

• Frame: frame around the datapoint present/not present.

• Text alignment: datapoint value and unit can be shown ei-
ther left-aligned, right-aligned or centred

• Font: select the font here

• Background colour: select the background colour of the
datapoint here

• Device: in standard mode, only the device description entry
is visible here. This means that only datapoints of the current
device can be used.
In the user-defined mode, by contrast, datapoints of all de-
vices that, in the device list, are contained in the same group/
street/ name as the chosen device can be selected.
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When the central unit is selected, all datapoints of all devices
of the current plant can be selected

• Width: can be set either automatically or manually

• Datapoint text: the datapoint text is the text defined in the
device description. The following properties can be assigned
to it: visible, distance from the datapoint, width of the data-
point text, and on which side of the datapoint the datapoint
text shall appear

Editing datapoints

Introduction
In standard mode, datapoints can only be edited when using a special
version of the ACS111. In the user-defined mode, anybody can edit data-
points. The edit mode is activated by selecting menu item "Edit mode"
with the right mouse button. Only one datapoint can be edited at a time.
The active datapoint is identified by a frame which has eight solid rectan-
gles. The size of the datapoint can be changed with the help of these
rectangles. When clicking in the centre, the datapoint can be shifted. It
can also be shifted with the arrow buttons. If, at the same time, the shift
key is pressed, the size can be selected.
A menu appears when pressing the right mouse button.
It is used to select the properties of the datapoint.

Created files
The "Plant Diagram" application produces a number of files where its
data can be stored.

Plant Diagram

Introduction
For every device and its plant diagram, a standard and a user-defined
plant diagram can be created. The pictures are filed in Bitmap format.

• Filename: for the standard pictures, the filename will be de-
rived from the name of the device description. For the user-
defined pictures, a random name will be generated

• Extension: .bmp for Windows Bitmap

Format
This file can be edited with a commercially available graphics program.

Datapoint file

Introduction
The datapoints used for the plant diagram and their settings are stored in
this file.
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• Filename: for the standard pictures, the filename will be de-
rived from the name of the standard description. For the
user-defined pictures, a random name will be generated

• Extension: .dps for the standard description and .dpc for the
user-defined description

Format
The file cannot be read as clear text. The data are filed in binary format.

Configuration file

Introduction
For the user-defined description, a configuration file will be created for
each plant file. The configuration file contains information that tells the
"Plant diagram" application witch plant diagramm and datapoint file be-
long to witch device.

• Filename: freely selectable

• Extension: .apc

Format
The configuration files are filed in text format and can be opened with a
commercially available text editor. It is recommend not to change these
files.
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General

Passwords
In the ACS111, certain access rights can be protected with passwords.

Editing passwords

Introduction
This window is opened when the ACS111 is started for the first time. It
can also be opened via the "Extras – Passwords…" menu, but this is
possible only if you are logged in as administrator.

Procedure
The passwords for the administrator, end-user, service staff and OEM
can be entered separately.

Administrator

This is the only password you have to create. It is used for changing the
passwords at a later stage.

The assumption is made that the user who installs and starts the ACS111
for the first time is regarded as the administrator of the ACS111.

End-user and service staff

These passwords are optional and need not necessarily be defined. The
ACS111 always assigns the highest access right where no password is
allocated.

For example: if the passwords for the end-user and service staff have not
been defined, the ACS111 automatically assigns the access right for
service staff on startup.
If only the password for service staff has been defined, the access right
for the end-user will be assigned.

If the passwords for the end-user and service staff have been defined,
the "Login" window appears. You need to enter the valid password for the
required access right and then choose the "OK" button.

OEM passwords

There are devices that have a password included in their Device Descrip-
tion. Such devices enable certain functions when entering that password.

Any number of OEM passwords can be entered. By entering a password
in the text field "Password" and then choosing the "Add" button, the
password will be included in the list of OEM passwords.
These passwords can be changed by choosing the "Change" button, and
cancelled by choosing the "Cancel" button.
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Logging in at the ACS111

Once the passwords are assigned, you need to log in at the ACS111 to
obtain certain access rights. When the ACS111 is started up and the
passwords for the end-user and service staff have been registered, the
"Log in" window appears and you need to enter the password for the re-
quired access rights.

Depending on whether the passwords for the end-user and service staff
have been registered, the ACS111 behaves differently on startup.

End-user Service Behaviour on startup

Not registered Not registered The ACS111 automatically assigns the
access rights for Service

Not registered Registered The ACS111 automatically assigns the
access rights for the end-user

Registered Registered The user needs to log in when starting up
the ACS111

The passwords can be edited or cancelled at any time, as often as you
want, but this is possible only if you are logged in with the administrator
password.
Select Password... from the Extras menu and the "Edit Passwords" win-
dow appears. Now, you can edit the passwords. By choosing the "OK"
button, you can accept the changes, or reject them by choosing the
"Cancel" button.

Language
The ACS111 can be operated in a number of languages.

Selecting the required language

Introduction
From this window, you can select the language you require.

List

• Select a language: the language you require

Check box

• Do not show this dialog any longer: select this option if
you want to use the same language most of the time so that
this window will not appear each time the ACS111 is started
up

Buttons

• Continue: the language has been selected and the window
will be closed
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Changing the language

Introduction
It is not possible to change the language while the ACS111 is running. If
you want to use a new language, you need to close the ACS111 and
make a new start. However, before closing the ACS111, make certain
that the "Language" window appears on startup.

Procedure

Select the Extras menu. The list of submenus appears. Make certain that
on the left side of the Language Selection submenu a little tick is set. If
that is not the case, select the Language Selection submenu to set the
tick.

Info

Introduction
This window provides information about the ACS111.

Text boxes

• Product names

• Product version

• Production number and data of production

• Copyright information
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Tips and Tricks

Desktop
The presentation of menus and the operation of the ACS111 are similar
to other Windows applications.

Presentation of menus

Menus contain functions that cannot be performed at certain times be-
cause other functions may have to be called up first or because no con-
nection has as yet been opened.
Menu choices that cannot be performed yet are grey.

Operation

All menu items can also be activated without the mouse, by making use
of the keyboard. For this reason, menu items have one letter underlined.

So you can also select a menu item by pressing <ALT> <Letter>. For
more detailed information, refer to the ACS111 Operating Manual.

Also, so-called short-cuts (accelerator keys) have been introduced. By
pressing <ALT> + <Number>, it is possible to choose a menu item di-
rectly.

In addition, the menu items most frequently used are made available on
the tool bar for direct access.

For more detailed information, refer to the ACS111 Operating Manual.

Selecting colours

In most cases, the ACS111 makes use of Window's system colours. This
means that almost everything that is displayed uses a colour not prede-
fined by the ACS111. Hence, you can choose your own colours by using
the Windows colour configuration.

The only exception here are the data uploaded by the system via the se-
rial port which are then displayed. Such data are always displayed in text
boxes, independent of whether or not they can be edited. Such data may
also assume different statuses for which different colours are used.

The data uploaded by the serial port can have the following statuses:

• Not current: the data have already been uploaded. How-
ever, since the data were uploaded some time ago and, in
the meantime, the system data may have changed, it is not
certain if the displayed value represents the real system
value. These data are shown in red

• Current: it can be considered certain that the displayed data
represent the system data. They are shown in the Windows
standard colour for text (black)

• Edited, but not sent: the data have been edited on the PC,
but have not yet been sent from the PC to the system. The
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values displayed are those entered by the user, which are
probably not the same as the data existing in the system.
These data are shown in blue

In addition, the presentation of data changes to other general conditions,
for example in the case of:

• Problems: the data displayed do not exist in the system, or
the value received by the system was wrong. With this kind
of data, it is not a value that is displayed, but an <Error mes-
sage>. The colour of the displayed data is that of current
data ( black or red)

• See status: the status (alarm, out of service, etc.) of a data-
point does not allow the datapoint value to be displayed. With
this kind of data, it is not a value that is displayed, but <a
clear text message>, or ----�, which means that you should
view the datapoint status. The colour of the displayed data is
that of current data (black or red)

Presentation of values

With the data presented, a differentiation must be made between data
delivered by the system and data produced internally on the PC.

• Data produced internally on the PC:
Certain data can be changed (edited), others can only be
displayed. Data that can be changed are shown in an edit
box. Data that cannot be changed, are displayed in a text
box.

• Data produced by the system:
Such data are always shown in text boxes, independent of
whether or not they can be edited. If they can be edited, you
can double-click on the data to open the "Data Point – Com-
mands" dialog, where you can change the value. The data
delivered by the system are also shown in different colours
(refer to section "Selecting the colours").

Uploaded data
In some applications, data uploaded from a plant can be exported as a
file. Normally, such data are saved on the installation path of the ACS111
(....\ACS111\<File name>.<File type>).

Most of these data can be accessed by a standard spreadsheet program
or editor.

Communication
For information about the hardware connection of the OZW10 central unit
to the PC, refer to the ACS111 Operating Manual.
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Glossary of Terms

Modem

Device used for data transmission via telephone lines.

OZW10

M-bus central unit that stores the data of the connected devices.

Datapoint

Datapoints represent dynamic information. A differentiation is made be-
tween process data and operational data.

Process data are variables that, for application-specific reasons (usually
spontaneously "per event") are exchanged between process units (e.g.
sensor values, outside temperature, heat demand, etc.).

Operational data are used in connection with tools and user interfaces
for process visualization, commissioning or supervision of plant (setting
parameters, physical inputs and outputs, status information, general pro-
cess values, etc.).

The following information can be accessed in a device as an LPB data-
point, for instance:

• All variables that are accessible via local operation (setting
parameters or diagnostic data)

• Fault messages and alarms

• All process variables (via locally connected field devices or
communication)

• Time of day and time switch program

• Data used for device identification or device status

• ........

Device description

A device has dynamic information (process and operational data) made
available by the datapoints. In addition to the dynamic data, there is also
static descriptive information, the so-called device description, which en-
ables the devices to be described in a uniform and consistent manner.

This descriptive information is distributed offline and is not saved in the
device.

HMI

Human Machine Interface, e.g the ACS111.

ID

Identification (e.g. the name of the device description).

Masks

Masks are used to assign certain "filter properties" to each datapoint in
the device description. They can be used to mask out datapoints that are
of no interest, for instance.



70/72

Siemens Building Technologies Operating Instructions ACS111 CE1B5386en
Landis & Staefa Division Glossary of Terms 23.10.2000

The following masks are supported:

• Overview: data used for the device overview: key informa-
tion about the device’s status

• Configuration: general setting values, such as plant dia-
gram, bus address, controller operating mode, and time
switch programs

• Setpoints: setpoints, such as the normal room temperature
setpoint, reduced room temperature setpoint, maintained
boiler return temperature, or maximum limitation of boiler
temperature

• Control Parameters: control parameters, such as the build-
ing time constant, P-band, neutral zone of mixing valve, or
slope of heating curve

• Diagnostics: for diagnostic purposes when doing service
work, e.g. device fault message, outside temperature source,
various actual values, hours run, status of digital inputs and
outputs

• I/O data: data that are dependent on sensors, actuators,
digital inputs and outputs, room units and other field devices,
e.g. the actual values of various sensors, or the status of
digital inputs and outputs

• Normal User: data intended for the end-user only

• Setup Protocol: data that should be contained in a setup
protocol, such as type reference, serial number, all setting
parameters, and various actual values
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